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Preface 

 
This manual applies to the Tunstall Nursecall Information 
System application. It provides general information and 
specific instructions on:  

• Using the TNIS package. 
 
This manual should be used as: 

• A reference guide for system engineers and technicians 
responsible for installing and configuring the software. 

• An operation guide for everyday users. 
 
This manual assumes the reader has a sound knowledge of 
Windows NT / Windows 2000. 
 
The following trademarks belong to the companies listed: 

• Tunstall, Nursecall, Nursecall, Haven – Tunstall Canada 
Inc. 

• Definity – Avaya Inc. 

• MS Windows – Microsoft Corporation 
The use of these and any other trademarked names registered 
or otherwise, is for editorial purposes only, with no intention of 
infringement of the trademark. 
 

iv                                                                                                                                                           TNIS – User Guide 



Section 1 - Introduction 

Overview 
The Tunstall Nursecall Information System (TNIS) package is 
a unique application that complements your Tunstall Nurse 
Call system.  The TNIS records detailed information about all 
the calls made on the Tunstall system and allows reports and 
charts to be created in order to analyse this data.  The TNIS is 
essential for monitoring your staff and facility.  
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Requirements 
 

Hardware 
To use the TNIS Package, you need the following: 

• An IBM-Compatible computer with a Pentium III or 
compatible processor; 233 MHz or better is recommended. 

• A minimum of 64 MB (megabytes) of RAM. (Random 
access memory) 

• A hard disk with 2 GB (gigabyte) of free disk space. 

• A 8x CD-ROM drive or better. 

• A VGA (or better) video card and monitor; a display system 
capable of a least 256 colors with a screen resolution of at 
least 800 X 600 is recommended. 

• A printer supported by your operating system, if you plan to 
print reports or charts from the TNIS. 

• At least one serial port. 
 
 

Software  
The computer requires the following operating system and 
software packages loaded onto its hard drive: 

• Either Windows NT 4.0 (with service pack 6 or later) or 
Windows 2000 (with service pack 2 or later) 

• TNIS software 
 
The TNIS software must be installed after the standard 
Windows NT or Windows 2000 operating system and service 
packs have been installed. 
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Content Of The Manual 
This manual explains the installation, configuration, and 
operation of the Tunstall Nursecall Information System 
software. 
 

SECTION 1 - INTRODUCTION 
 Provides a summary of the main features of the 

Tunstall Nursecall Information System software 
package, and a list of the hardware and software 
requirements. 

 

SECTION 2 - INSTALLATION 
 Describes how to install the Tunstall Nursecall 

Information System software package. 
 

SECTION 3 - CONFIGURATION 
 Describes how to configure the Tunstall Nursecall 

Information System software package. 
 

SECTION 4 - OPERATION 
 Describes how to use different functional modules 

of the Tunstall Nursecall Information System 
software package. 

 

SECTION 4 - CONTACTS 
  List of contacts. 
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Section 2 - Installation 

Tunstall Nursecall Information System Installation 
 
 

Hardware Installation 
All hardware should be installed prior to software installation. 

 
 

Software Installation 
If the computer operating system is not loaded, follow the 
installation procedure described in the Windows NT/2000 
Installation Manual to install: 

• Operating System  

• Service packs 
 

To install the TNIS package complete the following steps: 
 
1. Shut down all running applications and any virus protection 

software you may have. (Some virus protection software 
can interfere with the installer) 

2. Insert the TNIS CD into your computer’s CD-ROM drive. 
3. On the your computer’s CD-ROM drive double click the 

MSDEInstall.exe.  Follow the on screen directions until set-
up is complete. 

Note:  Install my take several minutes.  Please wait until 
you see “Finish” before continuing setup.    

4. Click “Finish” and reboot the computer. 
5. Next, ensure that the MSSQL Server is running.  From the 

“Start/Programs/MSDE/” menu click “Service Manager”  
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                    Figure 1 - SQL Server 
 

• Verify that there is a green arrow displayed on the 
server icon.  (Figure 1) 

• If the server is not running follow the steps below: 

• Select “MSSQL Server” from the “Services” 
dropdown box and click the “Start/Continue” 
arrow. 

• Wait until you see the green arrow icon that 
verifies that the server is running. 

• Once the server is running ensure that the “Auto-start 
service when OS Starts” check box is selected and 
close the window. 

 
Note: The server must be running at all times. 
 

6. Next, on the your computer’s CD-ROM drive double click 
the TNISInstall.exe.  Follow the on screen directions until 
set-up is complete.  Click “Finish” and reboot the 
computer. 
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7. Next, you must create an ODBC data Source.  From the 
Control Panel (Start/Settings/Control Panel) double click 
the “ODBC Data Sources (32bit)” icon.  

• From the “System DSN” Tab click the “Add” button. 
 

 

                             Figure 2 - ODBC Data Source 

• Select the “SQL Server” driver from the list and click 
the “Finish” button. 

• On the next screen enter “sqlsrvpubs” in the Name text 
box and select “(local)” in the “Server” text box.  Click 
next.  (Figure 3) 

 

 

                                  Figure 3 - DSN and Server 
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• On the next screen ensure the following: 

• Select “With SQL Server authentication using a 
login ID and password entered by the user” 

• Deselect “Connect to SQL server to obtain 
default settings for the additional configuration 
options.” 

• Accept the default settings on the next screen and click 
“Next”.  

• Accept the default settings on the next screen and 
Click “Finish”. 

• Click “Test Data Source” to verify the connection. 

• Click “OK” to complete the task.  
8. Software installation is complete.  
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Section 3 - Configuration 

Tunstall Nursecall Information System Configuration 
 
The majority of TNIS is pre-configured.  There are, however, a 
few steps that need to be performed in order to run and utilize 
the full power of the application.  To start the application, 
select the TNIS icon under the “Start” “Programs” menu of 
your computer. 
 

Serial Port Configuration 
 
The first step involved in setting up your application is to 
configure the serial port(s).  Under the “Settings” menu choose 
the Serial Port item.  The following window will appear.  
 

 

              Figure 4 - Serial Port Settings 
 
From this window, simply enable the appropriate Serial Port(s) 
and select the proper settings from the drop down lists.  Once 
you have made your selections click “OK” to confirm them and 
close the window.    
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Important: The standard Tunstall system typically uses the 
following settings: 

• Baud = 2400 

• DataBits = 8 

• Parity = No parity 

• StopBits = 1 
If the above settings do not work please contact your Tunstall 
service agent.  

 

Time Limits 
 
The next step in configuring your application is to set the “Time 
Limits” for the report.  Under the “Settings” menu choose the 
“Time Limits” item.  The following window will appear.  
 

 

                       Figure 5 - Time Limits 
 
The “Time Limits” window contains the following two settings: 
“Set Report Time-Out” and “Set Call Length Maximum”. 
 
The “Set Report Time-Out” setting is the amount of seconds 
that the report will attempt to retrieve data from the data-base.  
The default setting is 240 seconds. (4 Minutes)  The only 
reason for adjusting this setting would be if your reports were 
receiving time-out errors.  If this occurs simply increase the 
“Set Report Time-Out”. 
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The “Set Call Length Maximum” is the amount of time in 
minutes that the application will search for the answer (clear) 
to a call.  In some situations a “Call” may be placed and for 
some reason never “Cleared”.   
For Example:  A call was placed at 9:00PM and at 9:02PM the 
system was shut down. (i.e. due to maintenance or power 
failure) 
In this situation the call will never be Cleared.  The “Set Call 
Length Maximum” allows the user to define the amount of time 
that the application will search for a Clear before timing-out.  If 
the “Clear” exceeds this limit the call will be deleted.  The 
default setting is 30 minutes.     
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ID and Zone Configuration 
 
Configuring your TNIS involves entering the Unit ID’s (Room 
Numbers) used on your Tunstall system and assigning these 
ID’s to user-defined “Zones”.  The idea of assigning ID’s to 
zones is an extremely powerful tool.  This tool allows you to 
query the call information on your system not only by Unit ID 
but also by a group of ID’s (zones) that you can personally 
configure and name. 
 

Entering ID’s and Zones 

To enter ID’s and create Zones simply click on the “Configure” 
menu item and select “Modify Configuration”.  The following 
window will appear: 
 

 

                          Figure 6 - ID/Zone Configuration 
 
To enter an ID follow the steps below: 
 
1. Click the “New/Clear” button. 
2. Enter the Tunstall ID into the “Unit ID” text box. 
3. Next, enter the zone name in the “Zone” text box.  The 

zone is the group with which you want this ID to be 
associated.  For example:  If the Unit ID was on the 2nd 
floor of the residence you may want to call the zone 
“Second Floor”. 
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4. Next, enter a description in the “Description” text box.  
This section simply allows you to write a more explanatory 
description of the ID.  For example:  You could enter the 
location of that ID and the name of the resident.  

5. Next, click the  button to save your ID, Zone and 
Description.  Your new ID should now be visible in the 
“Unit ID’s” list box on the left side of the configuration 
window. 

6. Repeat this process until you have entered all of the Unit 
ID’s. 

7. Click “OK” to close the configuration window. 
 

Editing ID’s and Zones 

After you have entered your ID’s and Zones you can edit them 
at any time.  To edit them follow the steps below:   
1. Click on the “Configure” menu item and select “Modify 

Configuration”. 
2. Select the ID you wish to edit from the “Unit ID’s” list box 

located on the left side of the configuration window.  The 
selected ID’s information will be displayed in the 
appropriate text boxes on the right.  Next, simply modify 
the fields you wish to change and click the  button 
to save your changes. 

3. Click “OK” to close the configuration window. 
 

Deleting ID’s and Zones 

After you have entered your ID’s and Zones you can delete 
them at any time.  To delete an ID follow the steps below:   
1. Click on the “Configure” menu item and select “Modify 

Configuration”. 
2. Select the ID you wish to delete from the “Unit ID’s” list 

box located on the left side of the configuration window. 

3. Click the  button to delete the specific ID. 
4. Click “OK” to close the configuration window. 
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Shifts 
The final step in configuring your application is to create user-
defined shifts.  The unique ability to create shifts allows the 
user to query all call information on your system by a specific 
time period (shift).  This facility allows managers to view 
crucial data that enables them to properly staff and manage 
their facility by knowing which time shifts are the busiest.  This 
not only saves the facility money, but also provides the data 
that can ensure that residents are properly taken care of.  
 

Creating Shifts 

To create user-defined shifts simply click on the “Configure” 
menu item and select “Modify Configuration”.  Once the 
“Modify Configuration” screen is opened click on the “Shifts” 
tab. The following window will appear: 
 

 

                          Figure 7 - Shift Configuration 
 
To enter a shift, follow the steps below: 
1. Click the “New/Clear” button. 
2. Enter a shift name into the “Shift Name” text box. (i.e. 

Day) 
3. Enter the shift start time in the “Start Time” text box.   
4. Enter the shift end time in the “End Time” text box.  

5. Next, click the  button to save your shift.  Your new 
shift should now be visible in the “Shifts” list box on the 
left side of the configuration window. 
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6. Repeat this process until you have entered all of your 
shifts. 

7. Click “OK” to close the configuration window. 
  

Editing Shifts 

After you have created your shifts you can edit them at any 
time.  To edit them follow the steps below:   
1. Click on the “Configure” menu item, select “Modify 

Configuration” and click on the “Shifts” tab. 
2. Select the shift you wish to edit from the “Shifts” list box 

located on the left side of the configuration window.  The 
selected shift’s information will be displayed in the 
appropriate text boxes on the right.  Next, simply modify 
the fields you wish to change and click the  button 
to save your changes. 

3. Click “OK” to close the configuration window. 
 

Deleting Shifts 

After you have entered your shifts you can delete them at any 
time.  To delete a shift follow the steps below:   
1. Click on the “Configure” menu item, select “Modify 

Configuration” and click on the “Shifts” tab. 
2. Select the shift you wish to delete from the “Shifts” list box 

located on the left side of the configuration window. 

3. Click the  button to delete the specific shift. 
4. Click “OK” to close the configuration window. 
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Section 4 - Operation 

Overview 
This section of the User’s Guide provides specific instructions 
on the everyday use of the Tunstall Nursecall Information 
System application. 
 
 
 

Reports  
The TNIS  has the ability to create various reports that give 
detailed information about all the call activity on your Tunstall 
system.  This section will describe how to create and 
understand the assortment of reports.  
 

Reports – All Calls  
The first report is the “All Calls” Report.  This report is an 
extremely powerful tool that enables a user to view all of the 
call information on the Tunstall system.   
 

 

                      Figure 8 - All Calls Report Criteria 
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To create an “All Calls” report, follow the steps below: 
1. Select “All Calls” from the menu bar on the left hand side 

of the screen. 
2. Select a start and end time for the report.  This is the time 

range that the report will display. 
3. Select a shift for which you want the report to return data.  

For example:  If you chose a shift (i.e. Day) that was 
configured as 7:00AM to 3:00PM, the report would display 
only data that occurred between that time range.  By 
default “(none)” is selected, meaning no shift information 
will be used in the report.  

4. Next, if you wish you may enable “call duration limits” for 
your report.  You would use this option if you wanted the 
report to display only the calls that had a duration either 
longer than or less that a specific amount of minutes.  For 
example:  If you wanted the report to show only the calls 
that had taken longer than 3 minutes to be cleared.  By 
default “call duration limits” is disabled, meaning duration 
limits will not be used in the report. 

5. Click the “Show Report” button in the bottom right hand 
corner of the application. 
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Reports – Calls by ID 
The second report you can create is  the “Calls by ID” report.  
This report has all the functionality of the “All Calls” report with 
the added capability of selecting calls by a specific ID. 
 

 

                          Figure 9 - Calls by ID Criteria 
 
To create a “Calls by ID” report, follow the steps below: 
1. Select “Calls by ID” from the menu bar on the left hand 

side of the screen. 
2. Select a start and end time for the report.  This is the time 

range that the report will display.  
3. Select a shift for which you want the report to return data.  

For example:  If you chose a shift (i.e. Day) that was 
configured as 7:00AM to 3:00PM, the report would display 
only data that occurred between that time range.  By 
default “(none)” is selected, meaning no shift information 
will be used in the report. 

4. Select the specific ID for which you wish to view the calls.   
5. Next, if you wish you may enable “call duration limits” for 

your report.  You would use this option if you wanted the 
report to display only the calls that had a duration either 
longer than or less that a specific amount of minutes.  For 
example:  If you wanted the report to show only the calls 
that had taken longer than 3 minutes to be cleared.  By 
default “call duration limits” is disabled, meaning duration 
limits will not be used in the report. 
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6. Click the “Show Report” button in the bottom right hand 
corner of the application. 

 

Reports – Calls by Zone 
 
The second report you can create is  “Calls by ID” report.  This 
report has all functionality of the “All Calls” report with the 
added ability select calls by a specific Zone. 
 

 

                      Figure 10 - Calls by Zone Criteria 
 
To create a “Calls by Zone” report, follow the steps below: 
1. Select “Calls by Zone” from the menu bar on the left hand 

side of the screen. 
2. Select a start and end time for the report.  This is the time 

range that the report will display.   
3. Select a shift for which you want the report to return data.  

For example:  If you chose a shift (i.e. Day) that was 
configured as 7:00AM to 3:00PM, the report would display 
only data that occurred between that time range.  By 
default “(none)” is selected, meaning no shift information 
will be used in the report. 

4. Select the specific Zone for which you wish to view the 
calls.   

5. Next, if you wish you may enable “call duration limits” for 
your report.  You would use this option if you wanted the 
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report to display only the calls that had a duration either 
longer than or less that a specific amount of minutes.  For 
example:  If you wanted the report to show only the calls 
that had taken longer than 3 minutes to be cleared.  By 
default “call duration limits” is disabled, meaning duration 
limits will not be used in the report. 

6. Click the “Show Report” button in the bottom right hand 
corner of the application. 
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Viewing and Understanding the Reports 
 

 

                              Figure 11 - Completed Report 

                     

Facility Name   
Displays the name of your facility. 

Report Date  
Displays the date the report was run. 

Report Criteria 
Displays the criteria used to create the report. 

Call Statistics 
Displays the statistics of the report. 

Call ID 
Displays the ID that made the call. 

Answer ID 
Displays the ID or Master Unit that answered the call. 
Call Time 
Displays the date and time that the call was made. 

Select Time   
Displays the time that the call was selected. 

Clear Time 
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Displays the time that the call was cleared. 

Cancel 
Displays the time that the call was canceled. 

Select Duration 
Displays the duration of time between the call time and the 
select time. 

Clear Duration 
Displays the duration of time between the select time and the 
clear time. 

Total Duration 
Displays the duration of time between the call time and the 
clear time. 

  

Printing and Exporting Reports 
TNIS  allows the user to both print and export reports. 
 

 

        Figure 12 - Print 
 
To print a report, simply click the printer icon located at the top 
of the report window.  This will display the printer dialogue box 
that will allow you to print your report. 
 

 

                   Figure 13 - Print Dialogue box 
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             Figure 14 - Export Report 
 
To export a report, simply click the export icon located at the 
top of the report window.  This will display the export dialogue 
box that will allow you to save your report. 
 

 

                         Figure 15 - Export Dialogue Box 
 

Note: TNIS  allows the user to export a report as either a 
text or an html file. 
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Distribution Charts 
Distribution Charts is a powerful tool that allows users to view 
the amount of calls that their facility receives in a graphical 
chart format.  This feature, like the reporting feature, allows the 
charts to show data for “All Calls”, “Calls by ID” and “Calls by 
Zone”.  Furthermore, the charts can display data for a “24 hour 
period”, a “31 day period” or a  “52 week period”.   
 

Charts – All Calls 
 

 

                     Figure 16 - Call Distribution Chart 
 
To create a distribution chart simply follow the steps below: 
1. Select a “call distribution period type” from the drop down 

box.   
24 Hour Distribution – Number of calls per hour for a 24 
hour period. 
31 Day Distribution – Number of calls per day for a 31 day 
period.   
52 Week Distribution – Number of calls per week for a 52 
week period. 

2. Select a start date for the call distribution chart.  For 
example:  If you chose a 52 Week Distribution period with 
a start date of Dec 1st 1999, the report would show the 
amount of calls per week for 52 weeks starting on Dec 1st 
1999. 
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3. Click the “Show Chart” button located at the bottom of your 
screen.    

 

Charts – Calls by ID 
 

 

                            Figure 17 - Call Distribution by ID 
 
The “Call Distribution by ID” is the same as the “All Calls” 
distribution chart except that it allows you to chart the number 
of calls for a specific unit ID. 
To create a “Call Distribution by ID” chart simply follow the 
steps below: 
1. Select a call distribution period type from the drop down 

box.   
24 Hour Distribution – Number of calls per hour for a 24 
hour period. 
31 Day Distribution – Number of calls per day for a 31 day 
period.   
52 Week Distribution – Number of calls per week for a 52 
week period. 

2. Select a start date for the call distribution chart.  For 
example:  If you chose a “24 Hour Distribution” period with 
a start date of May 3rd 2001, the report would show the 
amount of calls for that day’s 24 hour period. 
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3. Select the unit ID for which you would like the results 
displayed. 

4. Click the “Show Chart” button located at the bottom of your 
screen. 

 
 

Charts – Calls by Zone 
 

 

                    Figure 18 - Call Distribution by Zone 
 
The “Call Distribution by Zone” is the same a the “All Calls” 
distribution chart except that it allows you to chart the number 
of calls for a specific zone. 
To create a “Call Distribution by Zone” chart simply follow the 
steps below: 
1. Select a call distribution period type from the drop down 

box.   
24 Hour Distribution – Number of calls per hour for a 24 
hour period. 
31 Day Distribution – Number of calls per day for a 31 day 
period.   
52 Week Distribution – Number of calls per week for a 52 
week period. 
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2. Select a start date for the call distribution chart.  For 
example:  If you chose a 31 Day Distribution period with a 
start date of April 5th 2001, the report would show the 
amount of calls per day for 31 days starting on April 5th, 
2001.   

3. Select the Zone for which you want the results displayed. 
4. Click the “Show Chart” button located at the bottom of your 

screen. 
 

Charts Viewing and Printing 
 

                          Figure 19 - Call Distribution Chart 
 
The completed chart is easy to read.  It shows the number of 
calls on the y-axis and the hours on the x-axis.  These charts 
prove to be invaluable when trying to staff and monitor a 
facility.  For example:  This chart shows that the hour between 
8:00AM and 9:00AM was the busiest time of the day.  This 
may enable a manager to either put more staff on at this 
particular hour or to prohibit staff breaks during this time 
period. 
The menu at the top of the chart gives the user the following 
options:  

File  
Under the “File” menu the user can save or print the chart. 
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Edit 
Under the “Edit” menu the user can copy the chart to the 
clipboard. 

Tools 
Under the “Tools” menu the user can select whether or not to 
display the chart toolbar. 

View 
Under the “View” menu the user can choose whether to view 
the chart in “3D” or “2D”. 

Gallery 
Under the gallery menu the user can select the style of chart 
they wish to view. 
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System Activity Log 
 
The system activity log allows the user to view the raw data 
that is received from the Tunstall system. 
To view the system activity log, click on the “System Activity 
Log” button from the menu on the left hand side of the screen. 
 

 

                         Figure 20 - System Activity Log 
 
To use the system activity log follow the steps below: 
1. Select a start time. 
2. Select a start time.  
3. Click the “Get Log” button.   
 

Note: You may also print the activity log by clicking the “Print 
Log” button.   
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Furthermore, the “System Activity Screen” allows you to view 
live system messages.  To do this simply click on the “View 
Live Data” button located at the bottom of the screen.  The 
window below will be displayed. 
 

 

                              Figure 21 - Live Data View 
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Connection Status 
 
The purpose of this screen is to monitor and control the 
communications status of your system. 
To view the “Connection Status” screen, click on the 
“Connection Status” button from the menu on the left hand 
side of the screen.     
 

 

                          Figure 22 - Communication Status 
 
The display on the bottom of the screen will show the current 
communication status.  To start or stop the communications 
simply click the appropriate button. 
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Section 5 - Contacts 

 
 

Contacts 
If you have any questions or need any further information on 
your TNIS, please contact your Tunstall service agent or 
contact JS Bitstream Inc. 
 

Tunstall Canada Inc. 

Phone – 1-800-892-2205 
Website – www.tunstallcanada.com 
 

JS Bitstream Inc. 

Email – info@jsbitstream.com 
Website – www.jsbitstream.com 
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